
 

Release Notes 

U7233A/U7233B DDR1 

Compliance Test 

Application Software 

Keysight U7233A/U7233B Software Version 01.54 

Released Date: 21 April 2017 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.00.00627 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

06.00.00627 (9000 Series) 

File Name: SetupInfDDR101540000.exe 

Modifications 

– Fixed tCK(avg) which not able to run successfully. 

– Fixed  tJit(cc) Rising Measurement test that always give a result of 1 second. 

– Fixed Timing Tests which intermittently hang during Calibration of Read/Write signal. 

– Fixed unexpected prompt of speed grade checking during Clock Timing Tests. It happens 

even though the actual and measured speed grade is same. 

– Fixed tDQSS test which hangs on large DQS or DQ signal. 

– Fixed tDSS and tDSH tests which take wrong the clock edge as measurement reference. 

– Changed the criteria to stop folding eye diagram because of the new behavior of Eye 

folding on Infiniium software. 

Keysight U7233A/U7233B Software Version 01.53 

Released Date: 23 October 2015 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.50 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 
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5.50 (9000 Series) 

File Name: SetupInfDDR101530000.exe 

Modifications 

– Solve tWPST issue where this test is not able to locate Hi-impedance location in burst. 

– Add report item for tIS/tIH tests for reporting the connected signal to the oscilloscope 

channel. 

Keysight U7233A/U7233B Software Version 01.52.0001 

Released Date: 17 October 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR101520001.exe 

Modifications 

– Solved “Unterminated Query” that happen on tCH and tCL tests. 

– Solved the Environment Variables used in Application is should refer to the Keysight path 

instead of Agilent path. 

Keysight U7233A/U7233B Software Version 01.52 

Released Date: 03 October 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR101520000.exe 

Enhancements 

– Supports for Infiniium Oscilloscope Software version 5.20 

Agilent U7233A/U7233B Software Version 01.51 

Released Date: 15 August 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-
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Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR101510000.exe 

Modifications 

– Solve the Eye Diagram test where the Mask Test counter is reset when the horizontal scale 

value is changed in Infiniium Magneto. 

Agilent U7233A/U7233B Software Version 01.50 

Released Date: 30 May 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR101500000.exe 

Enhancements 

– Supports for Infiniium Oscilloscope Software version 5.00. 

Agilent U7233A Software Version 01.46 

Released Date: 06 May 2014 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 

2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101460000.exe 

Miscellaneous Notes 

– This will be the last version to support Infiniium 80000 Series and Infiniium Oscilloscope 

Baseline Version 4.20. 

New Features 

– You can now suppress connection prompts from the user interface (see Connect tab). 

– If a project opens as Read-Only and there are no settings conflicts with the current version 

of the app, you may use File > Save Project (Settings-Only) As menu item to extract the 

configuration (and no results) from that project. 
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o If you create this folder: 

(Win7)C:\ProgramData\Agilent\Infiniium\Apps\<app_name>\app\scripts (WinXP) 

C:\Documents and Settings\All Users\Application 

Data\Agilent\Infiniium\Apps\<app_name>\app\scripts 

o then menu item File > Execute Script… becomes visible and enables you to pick a 

file to execute (e.g a.Python or Visual Basic script). Scripts in this folder may also 

be executed via the Automation tab or remote interface. 

– HTML Report now includes probe info. 

Enhancements 

– Projects saved by previous versions of this application will open in read-only mode. 

– Now remembers the last location when saving/opening/exporting projects/files/etc. 

– Now supports .txt file extension for ARSL scripts. 

– Now reports Last Test Date using international format. 

– Fixed launch on Win7 for non-admin user. 

– Fixed statistics display for items in the  Referenced Values section. 

– HTML Report “User Comments” field now preserves line breaks. 

– InfiniiSim now includes new Delay option. 

– New option to control jump behavior when you double-click a test name on the Select 

Tests tab. See View > Preferences > Report. 

– Remote Interface updated to version 2.50. 

– InfiniiSim now includes new Normalize Gain option. 

– Fixed Connection tab "Suppress" checkbox. 

– When using BitifEye BIT2100 instrument for switch matrix, now requires minimum firmware 

version: 3.4-1.10. 

Agilent U7233A Software Version 01.45 

Released Date: 22 July 2013 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 
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2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101450000.exe 

Enhancements 

– Support for MSOX90000. 

Agilent U7233A Software Version 01.44 

Released Date: 22 May 2013 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 

2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101440000.exe 

Modifications 

– Solve Automation issue that makes application use the wrong data rate information for 

measurement. 

– Solve Eye Diagram Test issue where accumulated waveform on the screen is cleared after 

the test finish. 

– Correction on the error message of tIS and tIH tests which show the wrong threshold 

value. 

– Solve tLZDQ and tLZDQS tests for LPDDR that take the wrong clock edge for tests 

reference. 

Agilent U7233A Software Version 01.43 

Released Date: 22 July 2013 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 

2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101430000.exe 

Modifications 

– Eye Diagram Test only report one waveform on the result image instead of reporting 

accumulated waveform. 

– Vih(ac), Vih(dc), Vil(ac), Vil(dc) tests is not successful if the signal's pulse is far apart. 

– Eye diagram is not successful for the next trial if user uses different PUT. 
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– Vih(ac), Vih(dc), Vil(ac), Vil(dc)  not able to run for PUT is Data Mask. 

– Project loading issue: load default test limit set instead of saved test limit set. 

– LPDDR1 tDQSCK: test use the wrong clock edge as reference of tDQSCK test. 

– SlewR test unable to run successfully. 

– Connection tab show connection to Channel-1 while select PUT as Address/Command for 

Electrical Single Ended Tests. 

– Solve SlewF test issue which performs measurement on rising Edge. 

Agilent U7233A Software Version 01.42 

Released Date: 01 October 2013 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 

2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101420000.exe 

Enhancements 

– Upgraded framework to version 3.60 to support Window 7 platform. 

Agilent U7233A Software Version 01.41 

Released Date: 25 May 2011 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 

2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101410000.exe 

New Features 

– Enabled the InfiniiSim de-embedding function setting of the oscilloscope. 

 

Agilent U7233A Software Version 01.40 

Released Date: 04 October 2010 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 
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2.10 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfDDR101400000.exe 

Enhancements 

– Supports the Infiniium DSO-X 90000 Series High Performance Oscilloscope. 

– The application will now require Microsoft’s .net framework 3.5 to be installed on the scope 

in order to run. 

– Updated the histogram measurement method in order for the application to support DSO-

X 90000 series. 

Agilent U7233A Software Version 01.32 

Released Date: 15 April 2010 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.71 (80000 Series), 

2.10 (9000 Series, 90000 Series) 

File Name: SetupInfDDR10132.exe 

Modifications 

– Fixed unable to load mask files with extra white space in first line. 

Agilent U7233A Software Version 01.31 

Released Date: 18 August 2009 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.70 (80000 Series), 

2.00 (9000 Series),  

1.41 (90000 Series) 

File Name: SetupInfDDR10131.exe 

New Features 

– Added support for various Low Power DDR1 devices. 

Modifications 

– Renamed name of settings in “Read and Write Separation Settings” section in Configure. 
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Agilent U7233A Software Version 01.30 

Released Date: 26 June 2009 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.70 (80000 Series), 

2.00 (9000 Series),  

1.41 (90000 Series) 

File Name: SetupInfDDR10130.exe 

New Features 

– Added the Eye Diagram test for Read and Write cycle. 

– Added the User Defined Limit feature. 

– Added support for the Low Power DDR1 as per JESD209A. 

– Added features to skip connection diagram prompt. 

Modifications 

– Improved the tDS/tDH Infinite Persistence Methodology to retrieve more data in less time 

and increase the test efficiency. 

– Updated the reference to JESD79F. 

– Modified the tAC and tDQSCK measurements to support JESD209A. 

– Renamed the Advanced Debug mode to Custom mode (Set Up tab). 

– Renamed ‘Stop on Error’ message to ‘Skip Error’ (Configure tab). 

– Removed the High/Low State Ringing Tests. 

– Removed the following tests: 

o (Optional) tDQSQ – (Infinite Persistanence Mode) 

o (Optional) tDS - Infinite Persistanence Mode 

o (Optional) tDH - Infinite Persistanence Mode 

– Project files saved in earlier version can only be loaded as read-only. 

Agilent U7233A Software Version 01.20 

Released Date: 26 June 2009 
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Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.30 (80000 Series),  

1.00 (90000 Series) 

File Name: SetupInfDDR10120.exe 

Modifications 

– Fixed bug which caused application failed to proceed during signal calibration while 

running on 90000 series oscilloscope with baseline version 1.20. 

Agilent U7233A Software Version 01.11 

Released Date: 07 March 2008 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.30 (80000 Series),  

1.00 (90000 Series) 

File Name: SetupInfDDR10111.exe 

New Features 

– Added Individual threshold setting for manual “threshold setting mode” specially designed 

for most embedded user. 

– Added InfiniiScan Min/Max setting in the configuration page. 

– Added optional Infinite Persistence test for tDQSQ(Read-cycle test) and tDS/tDH(Write-

cycle) tests. Infinite Persistence will measure setup and hold time of the respective signals 

and measure using the histogram mode. 

– Added configuration options for Single-Ended Signals (eg. DQS0,Gnd, /DQS0,Gnd) to 

provide more connection choices for the users. 

– Added tangent slew rate for the tDQSQ, tDS, tDH tests. Tangent slew rate and Nominal 

slew rate will be reported in the test results. 

– Added derating table measurement for tDS and tDH tests based on the tangent and 

nominal slew rate. Unmatched slew rate will returned “N/A” in the result table. 

– Added total measurement measured for the Timing Tests. This information will be available 

at test result’s report. 

Agilent U7233A Software Version 01.10 

Released Date: 11 January 2008 
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Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.30 (80000 Series),  

1.00 (90000 Series) 

File Name: SetupInfDDR10110.exe 

New Features 

– Supports the Infiniium 90000 Series High Performance Oscilloscope. 

– Supports the Remote Programming Interface capability. 

– Performance enhancement on all the Electrical and Timing tests. 

– Enable running of all test without any connection prompt during the run in order to let the 

system run nightly. 

Agilent U7233A Software Version 01.00 

Released Date: 17 September 2007 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.30 (80000 Series) 

File Name: SetupInfDDR10100.exe 

Initial Release 
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